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II Salón de Negocios 
Digitales convoca a 
más de mil asistentes
• El evento, organizado por Asimpres y Revista Contraseña, contó 
con 625 m2 de equipamiento y 21 expositores. En cuanto al perfil 
del visitante, en esta oportunidad fueron los representantes de 
imprentas quienes asistieron en mayor número que en la versión 
anterior que destacó la presencia de diseñadores y publicistas.

Juan Alberto Fierro, de Rhein:

“El desafío principal 
de la Gráfica es la 
adaptación constante a 
las transformaciones”

Juan Pisano, de Empresas Jordan:

“Si la Industria no asume 
los cambios que se están 
produciendo, muchas van 
a desaparecer”

● En el concurso podrán competir productos impresos en todo 
el pais durante el periodo comprendido entre el 1 de julio de 
2011 y el 31 de agosto de 2012. Página 3
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RELACIÓN VERTICAL: Afiche, Pendón, Portada, Polera.

RELACIÓN HORIZONTAL: Credencial, Ficha Técnica, Placa Premio.

RELACIÓN EXTRA HORIZONTAL: Cabezal Reglamento, Aviso Pie de Página, Banner en Página Web. 

Premio AUSTRALIS 2012

Conferencia técnica
El 25 de septiembre, de 19:00 a 21:00 horas, 
se desarrollará el seminario ‘El Futuro de la 
Impresión Offset’.

Inauguran Mural en la Escuela 
de la Industria Gráfica
El 25 de agosto en el contexto del tradicional 
almuerzo de los ex alumnos, se inauguró el 
Mural ¡SE IMPRIME!

La Nación 
El directorio de la empresa periodística 
someterá a votación de sus accionistas, la 
disolución anticipada y liquidación de los 
bienes de la sociedad.8 8 8

Páginas 6 y 7
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TECNOLOGÍA
José Bodet
Consultor Gráfico Internacional
Asesor Escuela de la Industria Gráfica
Director Académico CFT INGRAF

josebodet@me.com

¿Y qué hay para 
los gráficos?
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¿Por qué el 5,3% de creci-
miento evidenciado por el 
Imacec de julio y el 5,4% de 
expansión experimentada 
por la economía chilena en 

el primer semestre, son tan dispares 
a los índices que está generando la 
Industria Gráfica Nacional?
 
Los recientes indicadores proporcio-
nados por el Departamento de Estu-
dios de la Sociedad de Fomento Fabril 
(Sofofa), señalan que la variación de 
la producción de la Industria Gráfi-
ca Nacional correspondiente al mes 
de julio fue de -13,4% frente a junio 
y de -8,8% con respecto a igual lap-
so de 2011. A su vez, comparando los 
mismos períodos, el índice de ventas 
físicas arrojó resultados negativos en 
5,7% y 11,7% con relación al mismo ciclo 
del año anterior, resultados que en el 
mes de septiembre, posiblemente se 

verán aun más afectados por el largo 
feriado que tuvimos para celebrar la 
Independencia nacional.

La alta base de comparación inte-
ranual impuesta por un buen año 
2011; la persistente caída de las ex-
portaciones; la disminución de la 
demanda interna durante el período 
invernal; la sobrecapacidad instala-
da; el estancamiento de la eficien-
cia productiva y la exigua incidencia 
que tiene la Industria Gráfica en los 
índices macroeconómicos naciona-
les, son todas respuestas válidas y 
complementarias que no justifican 
el seguir quitándole valor a nuestra 
Industria para hacer frente a un esce-
nario externo bastante más benigno 
que lo proyectado hace meses atrás. 

Por el contrario, las cifras hablan 
ya de un aumento en la estimación 

del crecimiento para el presente año 
proyectado en el reciente Informe de 
Política Monetaria del Banco Cen-
tral (IPoM). Se ve, además, una eco-
nomía creando empleos a un ritmo 
más alto que el del número de perso-
nas que entra  al mundo laboral. El 
consumo, en tanto, no se detiene y 
el comercio supera el 60% del PIB, y 
gracias a los resultados preliminares 
del Censo 2012, el PIB por habitante 
está llegando a US$ 18.500 (medido a 
PPC), alcanzando a los países medio-
alto del mundo. Aun más, los datos 
muestran una inversión extranjera 
80,2% superior al primer semestre 
del año anterior.

Considerando que la Industria Gráfi-
ca ya está transitando por el período 
más favorable del año, se debe recon-
siderar una posible sobrerreacción 
aplicada en el primer semestre. Hay 

que ponderar los ajustes para seguir 
aportando al desarrollo nacional, en 
miras a que el país continúe esqui-
vando exitosamente la crisis europea 
y el lento crecimiento estadouniden-
se, con una política contracíclica, que 
permitirá mantener el crecimiento 
por sobre el promedio de los países 
de la región durante el próximo año.

El futuro debe ser mucho mejor

Roberto Tapia Mc D.
Editor

O ¿Qué hay de los gráficos que aún viven 
para y del papel? Pareciera que, luego de la 
salida al mercado de las Creative Suite 6, 
los medios impresos y todos aquellos que 
viven de ellos ya no benefician del mismo 
cariño ¿Nostalgia? Por supuesto, pero queda 
claro que de hoy en adelante los medios 
digitales son los que atraen los focos e 
incentivan inversiones tecnológicas.

Adobe InDesign CS6

La última versión de InDesign CS6 nos llegó con 
toda una serie de novedades claramente en-
focadas a la creación y producción de publi-
caciones para tablets [mediante la Digital Pu-
blishing Platform del mismo Adobe] y hacia otros 

medios siendo todos aquellos digitales [ePub, Web, Flash...]. 
¿Novedades para el diseñador gráfico, la imprenta y 
medios impresos? Veamos a continuación...

Novedades para los amantes del papel
Para ayudar a saber qué hay de nuevo en InDesign CS6, 
nada mejor que activar la opción desde el menú Window 
> Workspace > New in CS6. Ahora, cada menú del programa 
muestra marcado de color azul aquellas funciones mejo-
radas o nuevas.

Una de las novedades que prefiero es la nueva función 
“Auto-Size” que se puede asignar a una caja de texto ha-
ciendo que ésta se auto-redimensione –sola– al momento 
de agregar o eliminar texto [Menú Object > Text Frame Options...]. 
Por ejemplo, puedes probar con la opción “Height Only” 
para que la caja de texto se agrande o reduzca vertical-
mente según sea el caso. Las flechitas del mismo cuadro 
de diálogo definen hacia dónde se produce el redimensio-
namiento. La combinación de esta nueva opción de caja 
con la ya conocida opción “Balance Columns” ofrece rea-
les beneficios en cuanto a productividad.

Place & Link del menú Edit es sin lugar a dudas la función 
más útil que se encuentra en esta última versión de InDe-
sign. Seleccionas un texto, una caja de texto o de imagen; 
menú Edit > Place & Link; se abre el “Conveyor”; luego haz 
un clic para colocar el elemento; éste se encuentra ahora 
vinculado al original. Modificas ese original (contenido 
y/o caja); es esos cambios se aplicarán al o los elementos 
vinculados (luego se hacer un clic sobre el ícono de link 
modificado). Desde la paleta Links podrás observar el 
estado de los elementos vinculados y en el menú de esta 
misma paleta encontrarás una nueva opción llamada “Go 
To Source” que, luego de haber seleccionado un elemento 
vinculado, te permite ir hacia el original (que sea en el 

mismo documento InDesign u otro). También pruebas las 
nuevas herramientas “Content Collector” (para agregar 
elementos al Conveyor) y “Content Placer” (para colocar 
elementos almacenados en el Conveyor). Usas las flechas 
de tu teclado para pasar de un elemento a otro. Y para 
terminar, fíjate en las nuevas opciones de vínculos para 
determinar lo que sí se actualizará y lo que no al mo-
mento de modificar la caja original de un texto o imagen 
[menú paleta Links > Link Options].

Para la Pre-prensa
Por fin se reconoce el número exacto de colores CMYK uti-
lizados en un archivo al momento de empaquetarlo [menú 
File > Package > pestaña: Colors and Inks]. Antes, siempre apare-
cían los cuatro colores CMYK como siendo utilizados.

Se puede exportar un archivo InDesign a todo color 
como PDF Blanco & Negro [pestaña Output > Color Conver-
sion: Convert to Destination; luego en Destination: seleccionar el 
perfil de Dot Gain correspondiente (15% para papeles es-
tucados; 20% para papel no estucados; 25% para periódi-
cos). Y también se puede previsualizar en B&N el archivo 
InDesign [menú View > Proof Setup > Custom].

Y las otras...
Las fuentes utilizadas en un documento InDesign se 
encuentran ahora al principio del menú Type > Font.

La paleta Align funciona por fin como la de Illustrator. 
Se puede pinchar el objeto sobre el cual los demás se 
alinearán.

Menú File > Export: se puede exportar una selección de 
objetos o páginas enteras al formato PNG y el formato 
PDF a la norma X-4 beneficia hoy de la compresión JPEG 
2000, más efectiva y menos destructiva.

No busques más como bajar la versión de tus archivos 
InDesign CS6 a versiones anteriores CS4 o CS5 [Menú File > 
Save as...].

En conclusión
InDesign CS6 ofrece al gráfico un número de novedades 
que no superan los dedos de una mano. ¿Vale entonces 
la pena actualizarse? O, mirando desde otra perspectiva 
¿Vale la pena seguir trabajando exclusivamente para 
medios impresos cuando la tecnología claramente va 
hacia medios digitales? Diseñadores e imprentas tienen 
que aprender a crear sinergia entre ambos mundos. Este 
será, junto con la impresión digital industrial, uno de 
los desafíos más importantes de los próximos años.
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Premio Austral is

Mª Alejandra Díaz
Directora de Cuentas 
Senior en DIL Brands 
Chile

Diseñadora Gráfica de 
la Universidad del Pa-
cífico. Profesional espe-
cializada en el desarro-
llo de proyectos de Pac-
kaging y Marcas. Pro-
fundización en sistemas 
de impresión y vasta 
experiencia en control 
y supervisión de vistos 
buenos de imprenta en 
Chile, Argentina, Brasil 
y El Salvador.

Información : secretaria@asimpres.cl

01-02-10
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Información : secretaria@asimpres.cl
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RELACIÓN VERTICAL: Afiche, Pendón, Portada, Polera.

RELACIÓN HORIZONTAL: Credencial, Ficha Técnica, Placa Premio.

RELACIÓN EXTRA HORIZONTAL: Cabezal Reglamento, Aviso Pie de Página, Banner en Página Web. 

Premio AUSTRALIS es un concurso abierto, pudiendo participar 
todas las imprentas establecidas en Chile, con productos impresos 

durante el periodo comprendido entre el 1 de julio de 2011 y el 
31 de agosto de 2012.

A continuación, se identifican las 17 categorías en que se podrá concursar: 

A IMPRESOS EDITORIALES 
A-1  Libros
A-2  Revistas 
A-3  Memorias e Informes Empresariales  
A-4  Catálogos

B IMPRESOS COMERCIALES
B-1  Folletos, Insertos y Desplegables 
B-2 Carpetas 
B-3 Agendas y Cuadernos
B-4 Formularios y Conjuntos de papelería
B-5 Valores, Raspes y Juegos de Azar
B-6 Calendarios

C IMPRESOS PACKAGING
C-1 Etiquetas 
C-2 Estuches y Envases Plegadizos
C-3 Envases Flexibles
C-4 Bolsas Impresas

D MATERIAL DE PUNTO DE VENTAS
D-1 Material promocional para el mostrador,   

 Colgantes P O P y exhibidores.
D-2 Afiches y Carteles

E PRODUCTOS AUTOPROMOCIONALES
E-1 Material Auto-promocional Impreso

Plazo para el envío de muestras: 31 de Octubre 2012

Valor de inscripción por muestra: Socios de ASIMPRES: $ 20.000 c/u - No Socios: $ 26.000 c/u

Bases y Reglamento del Concurso disponible en www.asimpres.cl o solicitarlo directamente a: estudios@asimpres.cl

Integrantes del Jurado Premio Australis

José Bodet
Director Académico del 
Centro de Formación 
Técnica INGRAF.

Ingeniero Gráfico francés 
con formación en diseño 
gráfico y preprensa di-
gital. Cuenta con exper-
tise a nivel de flujos de 
producción PDF, Color 
Management Systems, 
Control de Calidad y Es-
tandarización de flujos 
bajo ISO, Sistemas Edito-
riales, Software Gráficos 
y Tecnologías de impre-
sión digital.

Michael Bywaters
Experto en 
Comunicación e 
Impresión

Comunicador con 25 de 
experiencia en empresas 
de publicidad, diseño, fo-
tografía, productos edi-
toriales e impresión digi-
tal. Actualmente se des-
empeña como Gerente 
de Impresión Comercial 
e Industrial en IMAGEX. 
Ha oficiado de jurado en 
premios a la creatividad 
y eficiencia de campañas 
publicitarias.

Carlos Gallardo 
Especialista en 
Impresión Offset

Entrenador en Chile y el 
extranjero de impresión 
offset, con formación en 
Heidelberg, Alemania.

Actualmente se des-
empeña en la empresa 
HAGRAF, en labores de 
instrucción para la exce-
lencia en la impresión y 
representando a su com-
pañía en las Ferias Grá-
ficas Internacionales.

Santiago Aránguiz 
Decano de la Facultad 
de Diseño de la 
Universidad del Pacífico

Destacado profesional y 
docente en las áreas de 
Dibujo, Diseño e Histo-
ria del Arte. Se ha de-
sempeñado en el ámbito 
de la docencia y direc-
ción de las principales 
escuelas del país.

Jurado del Fondart des-
de el año 1992 y del 
Concurso Internacional 
Theobaldo di Nigris.

Rodolfo Díaz S.
Propietario Gerente 
de Encuadernaciones 
Rodisán Ltda. 

Profesional con más    
de cuarenta años de tra-
yectoria, con experien-
cia en encuadernación y 
restauración de impre-
sos. En la actualidad es 
propietario de un taller 
industrializado donde 
se ha fusionado la de-
dicación y la calidad en 
las terminaciones con la 
automatización y el tra-
bajo en línea.
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Se recuerda a los participantes del PREMIO AUSTRALIS que deseen concursar  en Premio Internacional Theobaldo di Nigris, 
enviar 2 muestras de cada producto para ingresar en ambos certámenes. 
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EducaGráfica

Tel.: (56 2) 373-4018  
www.datanetsa.comTel.: 600 300 36 36 / www.3mindustrial.cl 

Hace ya varios años está instalado en nuestra sociedad el concep-
to de RSE, responsabilidad social empresarial. La definición de 
este concepto es la contribución al desarrollo humano sosteni-
ble, a través del compromiso y la confianza de la empresa hacia 
sus empleados y las familias de éstos, hacia la sociedad en gene-

ral y hacia la comunidad local, en pos de mejorar el capital social y la calidad 
de vida de toda la comunidad.

Durante los últimos meses hemos visto en las calles de nuestro país una 
importante demanda por parte de distintos actores sobre cómo mejorar la 
calidad de la educación y cómo contribuye cada actor de la sociedad en esta 
tarea. Por otro lado, hemos comentado en otros artículos la demanda y nece-
sidad que existe hoy en chile por contar con técnicos de nivel superior que es-
tén realmente preparados para aportar en los distintos sectores industriales. 
Existe además consenso en que nuestra Industria Gráfica necesita de técnicos 
de nivel superior que contribuyan a mejorar el nivel de los índices productivos 
y que el concepto de “Maestros” ya no es suficiente para abordar los altos re-

Sello: Responsabilidad Educacional Empresarial
querimientos técnicos que enfrenta la producción.

Por todo lo anterior es que ya no podemos esperar que solamente el Estado se 
haga cargo de subir el nivel en la educación sobre todo técnica que es la que más 
nos afecta a nosotros. En este contexto, la formación DUAL y en ALTERNANCIA 
son un gran aporte a esta misión, ya que permiten la interacción y participación 
por parte de la empresa en esta tarea. Sin embargo implica también que la em-
presa asume cierta responsabilidad en este proceso.

En este contexto, el CFT ha desarrollado un sello llamado “Responsabilidad 
Educacional Empresarial”, el cual permite medir y premiar a aquellas empresas 
que aportan a la formación de su gente y provocan por tanto en su quehacer un 
impacto social importante para el desarrollo de la sociedad en nuestro país. Con 
esto la Industria de la Comunicación Gráfica continúa su política de aportar a 
la formación de nuestro país y se suma a muchas otras actividades que apuntan 
en esa dirección y que se transforman en referente para otros sectores produc-
tivos del país. Dejamos entonces la invitación abierta a todas las empresas que 
participan de esta Industria para que se sumen a esta iniciativa.

En En el marco del Salón de Negocios Di-
gitales 2012, se realizó el primer Congre-
so Internacional de Color Management, 
organizado y moderado por José Bodet, 
Director Académico del CFT INGRAF, en 

conjunto con Revista Contraseña.
A través de experiencias internacionales y nacio-

nales de éxito se expusieron, a través de un innova-
dor formato, métodos concisos y prácticos para op-
timizar la producción, trabajar más seguro, invertir 
mejor y reducir costos; oportunidad en que más de 
10 marcas presentaron lo último en tecnologías de 
Color Management.

Este evento contó con la participación de los si-
guientes panelistas destacados de la Industria Grá-
fica Nacional e Internacional:

Raimundo Illanes, Product Manager 
Estrategias y Medios Digitales – Celfin 
Capital, Adobe SLAM Evangelist. Camilo 
Mejías, Gerente Regional de Producto de 
Ricoh Latinoamérica. Rodrigo López, 
Jefe de Prensas del diario El Mercurio. 
Julio Pérez, Control e imposición digital 
del diario El Mercurio. Pedro Chacón, 
Supervisor Creativo grupo Coca-Cola de 
Mc Cann Erickson. Alejandro Ubilla, 
Adobe Expert Certified Master Design - 
Digital Publishing Consultant de CEPAL, 
Naciones Unidas. Doifel Videla, Fotógrafo 
y Profesor Universidad Católica, ARCIS 
y UNIACC, Dueño del taller de impresión 
digital FinalPrint. Gonzalo Díaz, Artista 
visual. Pintor, Instalador y Fotógrafo, 
Premio Nacional de Artes Plásticas de Chile, 
Profesor titular del taller de pintura de 
la Facultad de Artes de la Universidad de 
Chile. Jaime Ramírez, Gerente General de 
bLogik Ltda. Claudio Calderón, Product 
Manager de bLogik Ltda. Alex Leiva, 
Jefe Técnico en Aplicaciones y Color de Inser 
impresores. Robert Schmeisser, Digital 
Color Specialist Consultor. Raúl Jeria, 
Jefe Preprensa de Moller+R&B Impresores. 
Alejandra Díaz, Directora de Cuentas 
de Dil Brands. Rolando Calfio, Director 
Creativo de Dil Brands. Youri Popovitch, 
Global Services Director Latín America de Agfa 
Chile. Enrique Amigo, Director Servicios de 
Consultoría de GMG América Latina. Juan 
Páez, Gerente General de Hurst Labeling 
System. Jorge Fabregas, Desarrollo Técnico 
de Retográfica – Grupo Schawk. Manuel 
Valente, Sr. Sales Development Manager 
Fiery & Proofing de EFI Latin America. Oscar 
Vallejos, Jefe de Operaciones del diario Las 
Ultimas Noticias. David Arriagada, Jefe 
Preprensa de Copesa. Roberto Hevia, 
Asesor Técnico de Antalis GMS. Claudia 
Langlois, Product Manager Techkon de 
Antalis GMS. Cecil Rothfield, Gerente de 
Colortech – Grupo Dimacofi. Luis Piano, 
Director Piano & Piano.

Admisión 2013
Técnico Gráfico de Nivel Medio
Enseñanza Media: 1ro a 4to Medio.

Proceso de inscripción
Inscripción: Hasta el 31 de Octubre 2012
Horario de atención: Lunes a miércoles de 8:30 a 13:00 y de 
15:00 a 17:00 hrs; jueves y viernes de 8:30 a 13:00 hrs.

Test de selección
Lunes 5 de noviembre 2012 a las 13:45 hrs
Se publicará en el frontis de la escuela una lista única de 
preseleccionados el día jueves 8 de noviembre 2012 entre 8:30 
y 14:00 hrs.

Puertas abiertas
Miércoles 31 de octubre 2012 de 9:00 a 12:00 y de 14:00 a 
17:00 hrs.
Exposición de talleres de la especialidad. Visita guiada y 
entrada liberada.

Escuela de la Industria Gráfica
Florencia 1442, San Miguel, Santiago de Chile, 
Teléfono: 556 4543, rectoria@educagrafica.cl

www.educagrafica.cl

Requisitos: 15 años al 31/03/2013; Nota promedio por subsec-
tores no inferior a 5,2; Certificado médico (en formato entre-
gado por la escuela); Fotocopia de: Certificado de Nacimien-
to; R.U.N.; Libreta de notas de 8vo Básico; Certificado de 
notas de 7mo año (año 2011); Informe de Personalidad.

 Tel.: (56-2) 827 80 00 / www.hagraf.com
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Directores Electos

Ingeniero civil mecánico espe-
cializado en tecnología indus-
trial e informática es Juan Al-
berto Fierro, ejecutivo de Rhein 
que se incorpora como director 

a nuestra asociación gremial.
Nacido en Viña del Mar en 1956, re-

cibió su formación en el Colegio de los 
Sagrados Corazones de esa ciudad y en 
la Universidad Técnica Federico Santa 
María de Valparaíso.

¿Cómo fue su llegada a la Industria 
Gráfica?
Mi inicio en la Industria fue a tra-
vés de una asesoría en un proyecto de 
informática, para desarrollar un sis-
tema de manufactura. Luego de seis 
meses me integré a la empresa Rhein 
(Ordóñez S.A., entonces) en el área de 
Producción. No tengo vínculos fami-
liares anteriores en esta Industria, mi 
familia estuvo muy ligada a temas re-
lacionados con la industria naviera y 
la Armada.

¿Cuál ha sido su vínculo con Asimpres?
Hace ya muchos años me acerqué a 
Asimpres por el tema de capacitación 
y desarrollo de personal, participan-
do desde el inicio en los planes tipo 
Vulcano de educación colaborativa Es-
cuela-Industria. También, desde hace 
mucho tiempo, soy el representante 
de la empresa en Asimpres. También 
fui director de la Asociación de Indus-
triales de San Joaquín, instancia en 
que defendimos, exitosamente, la per-
manencia de actividades industriales 
dentro del anillo Américo Vespucio.

¿Cuál cree usted es el principal rol que 
tienen los gremios empresariales en la 
actualidad?
Los gremios deben representar los in-
tereses de sus asociados y canalizar las 

Nacido en Montevideo, 
Juan Pisano, nuevo 
miembro del directorio 
de Asimpres, es ingenie-
ro comercial de profe-

sión. Casado con chilena y con cinco hi-
jos, tiene varios estudios a su haber: es 
MBA con especialización en Marketing 
por la Pontificia Universidad Católica 
del Uruguay, Executive MBA por la Uni-
versidad Adolfo Ibáñez, PDE por la Uni-
versidad de Los Andes y también cursó 
varios programas ejecutivos en el MIT 
Sloan School of Business, en Boston.

¿Cómo fue su arribo a la Industria?
Trabajé en CMPC en Uruguay y luego en 
Argentina, hasta que en 1997 me trasla-
daron a Chile. En 2001 llegué a Jordan 
por un compañero de universidad. Des-
de esa fecha estoy como gerente comer-
cial y desde hace dos años como gerente 
comercial corporativo. En poco tiempo 
cumpliré 12 años en la Industria, aun-
que llevo más de 20 años ligado al mun-
do ‘del papel’.

¿Cuál ha sido su vínculo con Asimpres?
Jordan tuvo siempre una relación cer-
cana a Asimpres, contando incluso con 
un presidente (Tomás Flanagan, 1993). 
Yo comencé a acercarme participando 
en las fiestas de fin de año y los cam-
peonatos de golf. Ahí pude vivir de cer-
ca el esfuerzo desplegado por los direc-
tores en pos de la mejora de los asocia-
dos. Siempre me interesó participar en 
el ambiente gremial y fue así que este 
año tomé parte de la reunión pre-Dru-
pa, punto de inflexión para proponer 
mi candidatura.

¿Cuál cree es el principal rol que tie-
nen los gremios?
Velar por los intereses de todos los aso-
ciados en temas como legislación y re-

Juan Alberto Fierro: Juan Pisano:

“El desafío principal
de la Gráfica es la
adaptación constante a 
las transformaciones”

“Si la Industria no asume 
los cambios que se están 
produciendo, muchas van 
a desaparecer”

. EL EJECUTIVO DE 
RHEIN ESPERA DAR UNA 
MIRADA PARTICULAR A LA 
INSTANCIA, “QUE AYUDE 
Y ENRIQUEZCA” LA VISIÓN 
DE LOS OTROS SECTORES 
DE LA INDUSTRIA.

. EL EJECUTIVO DE JORDAN 
DICE QUE BUSCA APORTAR 
UNA VISIÓN AMPLIA, A FIN 
DE QUE EL GREMIO Y SUS 
SOCIOS PUEDAN ABORDAR 
DE BUENA FORMA LOS 
DESAFÍOS QUE SE AVECINAN.

inquietudes por las vías correspondien-
tes. Esto es muy difícil hacerlo indivi-
dualmente por empresa, ya que ante 
cualquier desacuerdo o conflicto con la 
autoridad, se queda expuesto a dificul-
tades. Además, se pueden desarrollar 
iniciativas adyacentes a la Industria, 
especialmente en el desarrollo y capaci-
tación de personas, de forma de impul-
sar mejoras en los desempeños perso-
nales y, por ende, de las empresas.

¿Cuáles son sus intereses en materia gre-
mial? ¿qué elementos cree puede apor-
tar usted y su empresa en el directorio?
La idea de participar en el directorio, 
tiene como objetivo trabajar por la In-
dustria y colaborar en su mejora inte-
gral. Nuestra empresa tiene una orien-
tación y experiencia en producir y co-
mercializar productos de consumo ma-
sivo, que no es frecuente en esta Indus-
tria muy enfocada al servicio. Espera-
mos dar una mirada diferente que ayu-
de y enriquezca la visión del directorio.

¿Cómo visualiza el momento por el 
que atraviesa la Industria?
Nuestra Industria ha sufrido fuertes 
cambios en los últimos tiempos, debi-
do a las nuevas tecnologías, especial-
mente por la irrupción del ‘fenóme-
no digital’ que ha impactado positi-
vamente (y negativamente también), 
tanto en los procesos como en los es-
pacios de mercado. El desafío es la 
adaptación constante al cambio, que 
cada vez tiene mayor velocidad.

glamentos, capacitación, tendencias 
del mercado, relación con proveedo-
res y una bolsa laboral. Es necesario fo-
mentar la participación masiva, ya que 
cuantas más empresas se asocien, más 
resultados y beneficios obtendremos.

¿Cuáles son sus intereses en materia 
gremial?
Mi interés es poder aportar una visión 
más amplia en cuanto a lo que se viene 
en el mundo de las comunicaciones, ya 
que nuestra Industria es un actor muy 
importante y no puede quedarse fuera 
de las nuevas tendencias y solamente 
ofrecer una alternativa que poco a poco 
va a quedar obsoleta. Personalmente y 
desde el punto de vista de la empresa, 
hemos vivido cómo los cambios tecno-
lógicos asociados a la web han transfor-
mado la Industria, y esto es imparable e 
irreversible. A todas las áreas más tem-
prano que tarde les va a afectar.

¿Cómo visualiza el momento actual 
de la Industria?
El momento es muy especial, ya que 
enfrentamos cambios radicales, y que 
o aprovechamos o nos quedamos en 
el pasado. Esos cambios se refieren al 
mundo de las comunicaciones vía e-
mail y redes sociales. Hoy estos medios 
son complementarios a nuestra Indus-
tria (papel) y los vemos como una ame-
naza, pero más rápido de lo que pensa-
mos el papel será un complemento del 
mundo electrónico. Si no nos subimos 
a este carro, muchos van a desaparecer.
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II Salón de Negocios Digitales:    convoca a más de mil asistentes

● El evento, organizado por Asimpres y revista 
Contraseña se realizó durante tres días en Espacio Riesco. 

Con 625 metros cuadrados de equipamiento, 
la segunda versión del Salón de Negocios 
Digitales, fue la oportunidad indicada 
para lanzar la últimas tecnologías y dar 
a conocer las novedades del mercado. 

Fueron 21 los expositores que quisieron estar presente 
este año, siete más que la versión anterior, de 2011.

Con un día más que el año pasado y 500 metros cua-
drados más de superficie de la feria, fueron 900 los 
visitantes acreditados. Ellos accedieron a una amplia 
oferta de configuraciones de impresión digital e insu-
mos orientadas a generar valor agregado.

En cuanto al perfil del visitante, en esta oportuni-
dad fueron los representantes de imprentas quienes 
asistieron en mayor número que en la versión anterior 
que destacó la presencia de diseñadores y publicistas.

Entre los nuevos expositores estuvieron: Muller Marti-
ni, Papermint, Control del Color, Blogik, Interscreen, 
A&L Vision, GYR, Impresoras Digitales, Blogik, Reboch 
y Grupo Sima.

Destacó la presencia de HP Indigo 7600, Xerox 1000, 
Ricoh Pro C751 EX, Konica Minolta, Epson SureColor 
S30670, el grupo Sima con plataformas de gran formato 
y camaplana y las innovadoras prensas para etiquetas 
industriales e impresión de sobres de Oki, representa-
das por Datanet. Similar configuración de impresión 
de etiquetas en Impresos Industriales, como también 
las soluciones de impresión de GyR para comenzar a 
vivir la experiencia digital. 

En materia de insumos destacó la innovación de An-
talis GMS con f lujos de trabajo, tecnologías digitales 

Tel.: 800 229 37 69 / www.xerox.cl

Septiembre 2012

El connotado pintor Alejandro Balbontín utilizó la tecnología digital 
para reproducir sus obras y firmarlas para los asistentes a la Feria.

El Presidente del BD, Nelson Cannoni, Vicepresidente de ASIMPRES 
junto al Expositor Sergio Espiñeira de Muller y Martini.

Stand de CANON OCE.

6

Tel.: (56-2) 387 10 00 
www.dipisa.cl

Tel.: (56-2) 375 24 00 
www.edipac.clwww.kodak.com 

Stand de HP e Imagex.
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S  o  l u  c  i o  n  e  s   C  o  n  f  i a  b  l e  s
Tel.: (56-2) 996 28 97 / info@simatecsa.cl

La alianza GMS ANTALIS, DATANET y EPSON presentaron sus soluciones gráficas.

Un equipo Konica Minolta fue sorteado por la empresa GyR 
entre los visitantes a la Feria.

Patricio Ramírez y Mario Calatayud,  representantes de la empresa expositora Impresoras Digitales.

Stand de DIMACOFI.

e insumos sustentables, con lo que se que hicieron 
parte de su stand. “La feria nos dio una gran oportu-
nidad para desplegar la creatividad de AntalisGMS. 
Transformamos el stand en un muestrario vivo de 
nuestros productos para que nuestros clientes y vi-
sitantes en general, pudieran ver la aplicación de 
la amplia variedad de sustratos que ofrecemos. Fue 
un gran desafío que resultó espectacular”, señaló 
Maribel Sánchez, subgerenta de marketing Comu-
nicación Visual.

Igualmente, llamó la atención A&L Visión con sus-
tratos metalizados y efectos 3D. 

En el área de finishing, nuevamente Simatec tuvo 
presencia con equipos manuales, semimanuales y 
automáticas, especialmente concebidos para impre-
sores digitales. Müller Martini, por primera vez, se 
hizo presente para confirmar su rol en el mercado 
de imprentas medianas con soluciones integradas. 
Por otra parte, Papermint anunció la pronta imple-
mentación de un área de negocios especialmente 
dedicada a terminaciones para impresos digitales, 
bajo demanda. 

A destacar estuvo la realización del Congreso Interna-
cional del Color y que se realizó de manera paralela 
a la feria, durante el 15 y 16 de agosto.

Dentro de los expositores destacados estuvieron Ran-
dy Swope, gerente de Negocios  para la Industria de 
Artes Gráficas para América Latina de Xerox, quien 
impartió la charla “Drupa 2012, el aprendizaje des-
pués de cerrado el espectáculo” y Fernando Urteaga, 
Group Manager, professional imaging products de 
Epson América, quien se refirió al tema “Versátil y 
productivo en gran formato”.

S  o  l  u  c  i  o  n  e  s   C  o  n  f  i  a  b  l  e  s

b Logik
Business Tools & Strategy
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La Nación
El directorio de la Empresa Periodística La Nación informó a la Superintendencia de Valores y Se-
guros (SVS), a través de un hecho esencial, que someterá a votación de sus accionistas, la disolu-
ción anticipada y liquidación de los bienes de la sociedad. La junta extraordinaria se realizará el 
lunes 24 de septiembre y supondrá el final del medio de comunicación, el cual, desde hace dos 
años, aparecía solamente vía web.

Inauguran Mural en la Escuela de la Industria Gráfica
El día sábado 25 de agosto en el contexto del tradicional almuerzo de los ex alumnos, se inauguró 
en la Escuela de la Industria Gráfica (Ex ENAG) el Mural ¡SE IMPRIME! en el que se resumen los 
200 años de la Imprenta en Chile, basada en el libro del mismo nombre del Investigador y Comu-
nicador visual Jorge Soto Veragua.

El Mural, de 28 metros, fue presentado ante los ex alumnos de diversas promociones, hoy empresa-
rios y técnicos que ennoblecen este oficio, quienes 
ayudaron a concretar este proyecto. Destacan los 
aportes de Imprenta ROM, Imprenta Italiana, 
Imprenta Minerva, Tekkrom, ByB Impresores, 
Procolor, Sepal Impresores, QuadGraphics, An-
dros, Alfabeta, G4 Impresores, Tecnicolor, Co-
lorScan, Fotoprint, Gráfica Digital y Tecniflex; 
los proveedores Kodak, Ferrostaal, Flint Group, 
Control Color, Ricoh, Imagex, Dibco y Sima; y 
el amplio apoyo de las entidades gremiales del 
sector, Asimpres, Cenem y Conagra. Vista general del Mural bajo protección del pasillo 

principal.

38 años de Antalis GMS
Junto a su equipo de colaboradores, Antalis GMS celebró sus 38 
años de servicio al área gráfica de nuestro país. En una concurri-
da cena en el Hotel Ritz-Carlton, la Compañía distinguió a sus 
colaboradores más antiguos, con Premios por 10 años –Verónica 
Muñoz y Odette Conley-, 20 años –Adriana Jory, Adriana Bus-
tos, Eliana Delorenzo, Rubén Díaz, Elsa María Gómez, Billi Jara, 
Juan Muñoz, Gonzalo Álvarez, Iván Hernández y Ximena Baha-
mondes- y 25 años de servicio –Celso Ramírez y Soledad Zúñiga.

Asimismo, se entregaron reconocimientos a las personas que 
encarnan los valores del Espíritu Antalis GMS: Patricia Hernández, 
en Santa Filomena, y Darío Heredia, en el centro de Distribución.

En su discurso, el gerente general de Antalis GMS, Álvaro Ide, destacó el liderazgo mantenido 
por la Compañía en estos 38 años, señalando su optimismo hacia el futuro, como empresa f lexible 
que se adapta a las necesidades del mercado ofreciendo hoy su amplia gama de soluciones digitales.

Conferencia:

El Futuro de la 
impresión 
offset
Martes 25 de Septiembre 2012
19:00 - 21:00 hrs
Santa Filomena 66 - Bellavista
Auditorio Gentileza Antalis GMS

O r g a n i z a :

Moderador: José Bodet

Novedades Tecnológicas Post-Drupa & Visión de Mercado
Fernando Alamos - Hagraf - Heidelberg

Maestros v/s Técnicos: Gestionar la Transición
Arturo Cabezas - Faret impresores

Prensistas: ¿Qué competencias para hoy y el futuro?
Omar Pedregal - Jefe Carreras Impresión CFT ingraf

Últimas Tecnologías en Control del Color Impreso
Claudia Langlois - P.M. Techkon - Antalis GMS

Dirigido a:
Gerentes y Jefes de RRHH; Gerentes, Jefes y Supervisores de Producción  

y Control de Calidad, Prensistas, Alumnos de EMTP y ESTP.

Cupos limitados - inscripción a:
secretaria@asimpres.cl - Fono: (02) 225 7706
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